Copyright © 2003 Parametric Technology Corporation. All Rights Reserved.

User and training documentation from Parametric Technology Corporation (PTC) is subject to the copyright laws of the United States and other countries and is provided under a license agreement that restricts copying, disclosure, and use of such documentation. PTC hereby grants to the licensed user the right to make copies in printed form of this documentation if provided on software media, but only for internal/personal use and in accordance with the license agreement under which the applicable software is licensed. Any copy made shall include the PTC copyright notice and any other proprietary notice provided by PTC. This documentation may not be disclosed, transferred, modified, or reduced to any form, including electronic media, or transmitted or made publicly available by any means without the prior written consent of PTC and no authorization is granted to make copies for such purposes.

Information described herein is furnished for general information only, is subject to change without notice, and should not be construed as a warranty or commitment by PTC. PTC assumes no responsibility or liability for any errors or inaccuracies that may appear in this document.

The software described in this document is provided under written license agreement, contains valuable trade secrets and proprietary information, and is protected by the copyright laws of the United States and other countries. It may not be copied or distributed in any form or medium, disclosed to third parties, or used in any manner not provided for in the software licenses agreement except with written prior approval from PTC. UNAUTHORIZED USE OF SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL PROSECUTION.

Registered Trademarks of Parametric Technology Corporation or a Subsidiary

Trademarks of Parametric Technology Corporation or a Subsidiary
Third-Party Trademarks
Adobe is a registered trademark of Adobe Systems. Advanced ClusterProven, ClusterProven, and the ClusterProven design are trademarks or registered trademarks of International Business Machines Corporation in the United States and other countries and are used under license. IBM Corporation does not warrant and is not responsible for the operation of this software product. AIX is a registered trademark of IBM Corporation. Allegro, Cadence, and Concept are registered trademarks of Cadence Design Systems, Inc. AutoCAD and AutoDesk Inventor are registered trademarks of Autodesk, Inc. Baan is a registered trademark of Baan Company. CADDAM and CATIA are registered trademarks of Dassault Systemes. COACH is a trademark of CADTRAIN, Inc. DOORS is a registered trademark of Telelogic AB. FLEXlm is a registered trademark of GLOBEtrotter Software, Inc. Geomagic is a registered trademark of Raindrop Geomagic, Inc.

EVERSYNC, GROOVE, GROOVEFEST, GROOVE.NET, GROOVE NETWORKS, iGROOVE, PEERWARE, and the interlocking circles logo are trademarks of Groove Networks, Inc. Helix is a trademark of Microcadam, Inc. HOOPS is a trademark of Tech Soft America, Inc. HP-UX is a registered trademark and Tru64 is a trademark of the Hewlett-Packard Company. I-DEAS, Metaphase, Parasolid, SHERPA, Solid Edge, and Unigraphics are trademarks or registered trademarks of Electronic Data Systems Corporation (EDS). InstallShield is a registered trademark and service mark of InstallShield Software Corporation in the United States and/or other countries. Intel is a registered trademark of Intel Corporation. IRIX is a registered trademark of Silicon Graphics, Inc. MatrixOne is a trademark of MatrixOne, Inc. Mentor Graphics and Board Station are registered trademarks and 3D Design, AMPLEx, and Design Manager are trademarks of Mentor Graphics Corporation. MEDUSA and STHENO are trademarks of CAD Schroer GmbH. Microsoft, Microsoft Project, Windows, the Windows logo, Windows NT, Visual Basic, and the Visual Basic logo are registered trademarks of Microsoft Corporation in the United States and/or other countries. Netscape and the Netscape N and Ship's Wheel logos are registered trademarks of Netscape Communications Corporation in the U.S. and other countries. Oracle is a registered trademark of Oracle Corporation. OrbixWeb is a registered trademark of IONA Technologies PLC. PDGS is a registered trademark of Ford Motor Company. RAND is a trademark of RAND Worldwide. Rational Rose is a registered trademark of Rational Software Corporation. RetrievalWare is a registered trademark of Convera Corporation. RosettaNet is a trademark and Partner Interchange Process and PIP are registered trademarks of "RosettaNet, a nonprofit organization. SAP and R/3 are registered trademarks of SAP AG Germany. SolidWorks is a registered trademark of SolidWorks Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. in the United States and in other countries. Products bearing SPARC trademarks are based upon an architecture developed by Sun Microsystems, Inc. Sun, Sun Microsystems, the Sun logo, Solaris, UltraSPARC, J ava and all J ava based marks, and “The Network is the Computer” are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and in other countries. Visual Tools is a trademark of Visual Kinematics, Inc. (VKI). VisualCafé is a trademark of WebGain, Inc. WebEx is a trademark of WebEx Communications, Inc.

Licensed Third-Party Technology Information
Certain PTC software products contain licensed third-party technology: Rational Rose 2000E is copyrighted software of Rational Software Corporation. RetrievalWare is copyrighted software of Convera Corporation. VisualCafé is copyrighted software of WebGain, Inc. VisualTools library is copyrighted software of Visual Kinematics, Inc. (VKI) containing confidential trade secret information belonging to VKI. HOOPS graphics system is a proprietary software product of, and is copyrighted by, Tech Soft America, Inc. G-POST is copyrighted software and a registered trademark of Intericm. VERICUT is copyrighted software and a registered trademark of CGTech. ProPLASTIC ADVISOR is powered by Moldflow technology. Moldflow is a registered trademark of Moldflow Corporation. The JPEG image output in the ProWeb.Publish module is based in part on the work of the independent JPEG Group. DFORMD.DLL is copyrighted software from Compaq Computer Corporation and may not be distributed. METIS, developed by George Karypis and Vipin Kumar at the University of Minnesota, can be researched at http://www.cs.umn.edu/~karypis/metis. METIS is © 1997 Regents of the University of Minnesota. LightWork Libraries are copyrighted by LightWork Design 1990-2001. Visual Basic for Applications and Internet Explorer is copyrighted software of Microsoft Corporation. Adobe Acrobat Reader is copyrighted software of Adobe Systems. Parasolid © Electronic Data Systems (EDS). Windchill Info*Engine Server contains IBM XML Parser for Java Edition and the IBM Lotus XSL Edition. Pop-up calendar components Copyright © 1998 Netscape Communications Corporation. All Rights Reserved. TECHNOMATIX is copyrighted software and contains proprietary information of Technomatix Technologies Ltd. Apache...
Server, Tomcat, Xalan, and Xerces are technologies developed by, and are copyrighted software of, the Apache Software Foundation (http://www.apache.org/) – their use is subject to the terms and limitations at: http://www.apache.org/LICENSE.txt. UnZip (© 1990-2001 Info-ZIP, All Rights Reserved) is provided “AS IS” and WITHOUT WARRANTY OF ANY KIND. For the complete Info-ZIP license see ftp://ftp.info-zip.org/pub/infozip/license.html. Gecko and Mozilla components are subject to the Mozilla Public License Version 1.1 at http://www.mozilla.org/MPL/. Software distributed under the MPL is distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the MPL for the specific language governing rights and limitations. Technology "Powered by Groove" is provided by Groove Networks, Inc. Technology "Powered by WebEx" is provided by WebEx Communications, Inc. Acrobat Reader is Copyright © 1998 Adobe Systems Inc. Oracle 8i run-time, Copyright © 2000 Oracle Corporation. The Java™ Telnet Applet (StatusPeer.java, TelnetIO.java, TelnetWrapper.java, TimedOutException.java), Copyright © 1996, 97 Mattias L. Jugel, Marcus Meißner, is redistributed under the GNU General Public License. This license is from the original copyright holder and the Applet is provided WITHOUT WARRANTY OF ANY KIND. You may obtain a copy of the source code for the Applet at http://www.mud.de/se/jta (for a charge of no more than the cost of physically performing the source distribution), by sending e-mail to leo@mud.de or marcus@mud.de— you are allowed to choose either distribution method. The source code is likewise provided under the GNU General Public License. GTK+The GIMP Toolkit are licensed under the GNU LGPL. You may obtain a copy of the source code at http://www.gtk.org/, which is likewise provided under the GNU LGPL. zlib software Copyright © 1995-2002 Jean-loup Gailly and Mark Adler.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS LEGEND
This document and the software described herein are Commercial Computer Documentation and Software, pursuant to FAR 12.212(a)-(b) (OCT'95) or DFARS 227.7202-1(a) and 227.7202-3(a) (JUN '95), is provided to the US Government under a limited commercial license only. For procurements predating the above clauses, use, duplication, or disclosure by the Government is subject to the restrictions set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS 252.227-7013 (OCT '88) or Commercial Computer Software-Restricted Rights at FAR 52.227-19(c)(1)-(2) (JUN '87), as applicable. 040103
Parametric Technology Corporation, 140 Kendrick Street, Needham, MA 02494 USA
Design Animation is a tool for creating animation sequences using Pro/ENGINEER® parts, assemblies, and mechanisms previously created in Mechanism Design.

Read the following topics for an introduction to Design Animation and information on how to get started:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introducing Design Animation</td>
<td>1-2</td>
</tr>
<tr>
<td>Accessing Design Animation</td>
<td>1-3</td>
</tr>
<tr>
<td>Learning Design Animation Basics</td>
<td>1-3</td>
</tr>
<tr>
<td>Limitations</td>
<td>1-8</td>
</tr>
</tbody>
</table>
Introducing Design Animation

The Design Animation module enables you to animate mechanisms previously created in Mechanism Design or any assembly from Pro/ENGINEER®. It differs from Pro/MECHANICA MOTION™ and Mechanism Design in that you can create animation sequences by linking a series of "snapshots", without being required to create joints or servo motors.

Design Animation is meant for both casual and expert CAD or Pro/ENGINEER users. Any designer or engineer can use Design Animation to:

- generate high-quality animations for sales and marketing presentations, management meetings, or design reviews
- animate assembly, disassembly, and maintenance sequences
- create complex, composite animations

The components of an animation can be controlled through the Design Animation timeline. The timeline appears below the Pro/ENGINEER graphics window. You can display, edit, move, and synchronize the components of the animation on the timeline.

Design Animation enables you to define key frame sequences, describing the position and orientation of parts and assemblies at specific times during the animation. Design Animation interpolates between the frames in the sequence to produce a smooth animation. You can include a sequence of key frames in an animation multiple times.

You can also control animation sequences by identifying key events during the animation to trigger subanimations (copies of animations inserted into the timeline) or other effects such as view orientation, transparency, and magnification. These view changes enable you to emphasize the most important aspects of your animation by focusing attention on the parts of the model that are changing during your animation.

You can define servo motors and specify a time in the animation when they will be active.

Another feature that adds to the versatility of Design Animation is multiple-body locking. You designate a lead body and one or more follower bodies, and specify a time during the animation when the body lock is active. During that time in the animation, the follower bodies will follow the lead body in the same relative position as when the lock took effect, as if they were glued together.

You can define an animation for a subassembly, and the animation can be used when the subassembly is included with the parent assembly. This makes it easy to define animations for small subsets of a large assembly, and bring them together for a combined presentation.
Accessing Design Animation

You access Design Animation from the Pro/ENGINEER Applications menu. This allows you to:

- work within the Pro/ENGINEER user interface
- operate on the Pro/ENGINEER geometry model
- use Pro/ENGINEER visualization, file manipulation, graphics, and printing tools

Servo motors, snapshots, bodies, and connection definitions created in Mechanism Design are inherited by Design Animation.

Note: If you have not used Mechanism Design to build your assembly, you cannot use the connection status or joint axis-based servo motor functionality in Design Animation.

Learning Design Animation Basics

Before using Design Animation, you should become familiar with some terminology and windows. Read the following topics to learn the basics of working with Design Animation:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminology</td>
<td>1-3</td>
</tr>
<tr>
<td>Design Animation Interface</td>
<td>1-5</td>
</tr>
</tbody>
</table>

Terminology

The following list describes terms and their definitions or common uses:

<table>
<thead>
<tr>
<th>Item</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>animation time domain</td>
<td>the time period, number of intervals, or time step for the current animation</td>
</tr>
<tr>
<td>body</td>
<td>a combination of parts that move together as one unit, similar to a body in Mechanism Design</td>
</tr>
<tr>
<td>connection</td>
<td>a set of constraints that ties two bodies together and restricts the relative motion of the bodies in some or all directions</td>
</tr>
<tr>
<td>connection status</td>
<td>defines the state (Enable, Disable, Locked, Unlocked) of a connection at a given time during an animation</td>
</tr>
<tr>
<td>display at time</td>
<td>a specification that describes how every component in an assembly is displayed at a given time (Blank, Wireframe, Hidden Line, No Hidden, or Shaded)</td>
</tr>
<tr>
<td>event</td>
<td>a named point in time. It serves as a reference for other animation components or events. You can create your own events or use system-defined events.</td>
</tr>
<tr>
<td>Item</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>geometric constraints</td>
<td>constraints between geometric entities on two bodies applied while using the dragging functionality</td>
</tr>
<tr>
<td>key frame sequence</td>
<td>a set of snapshots that establish the location of certain bodies at specific times</td>
</tr>
<tr>
<td>key frame sequence instance</td>
<td>a copy of a key frame sequence included on the timeline</td>
</tr>
<tr>
<td>multi-body locking</td>
<td>a temporary rigid attachment of follower bodies to a lead body for a specified period of time</td>
</tr>
<tr>
<td>servo motor</td>
<td>a component that specifies relative motion of two bodies on geometric entities or about a Mechanism Design joint connection</td>
</tr>
<tr>
<td>servo motor instance</td>
<td>a copy of a servo motor applied to the timeline for a specific time period</td>
</tr>
<tr>
<td>snapshot</td>
<td>a picture of the model with the bodies in a particular orientation and position</td>
</tr>
<tr>
<td>subanimation</td>
<td>an animation included as a component in the current animation. It may originate with a subassembly of the parent assembly. It appears on the timeline as a line, without any of its components shown. To see the features of the subanimation, click on the circle at the beginning or ending of the line.</td>
</tr>
<tr>
<td>system-defined events</td>
<td>default events defined by the system for each component of the animation. These can include start and end times for each component.</td>
</tr>
<tr>
<td>transparency at time</td>
<td>a specification that describes the degree of transparency or opacity for a selected assembly component at a given time during an animation</td>
</tr>
<tr>
<td>view at time</td>
<td>a view saved within Pro/ENGINEER (for example: FRONT) that defines the orientation and magnification from which a model is viewed at a given time during an animation</td>
</tr>
</tbody>
</table>
Design Animation Interface

You can use Design Animation through Pro/ENGINEER menu commands, or by clicking buttons on a toolbar, or by moving elements in the timeline. Following are examples of the Design Animation toolbar and the timeline.

Toolbar

The toolbar buttons represent Design Animation commands and act as a quick way to get to the appropriate dialog box. You can customize the toolbar to include only those commands you use regularly.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action/Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="image" /></td>
<td>Create a new animation</td>
</tr>
<tr>
<td><img src="image2.png" alt="image" /></td>
<td>Control icon visibility</td>
</tr>
<tr>
<td><img src="image3.png" alt="image" /></td>
<td>Define bodies</td>
</tr>
<tr>
<td><img src="image4.png" alt="image" /></td>
<td>Drag model</td>
</tr>
<tr>
<td><img src="image5.png" alt="image" /></td>
<td>Create key frame sequence</td>
</tr>
<tr>
<td><img src="image6.png" alt="image" /></td>
<td>Create body-body locking</td>
</tr>
<tr>
<td><img src="image7.png" alt="image" /></td>
<td>Start running the animation</td>
</tr>
<tr>
<td><img src="image8.png" alt="image" /></td>
<td>Play back the animation</td>
</tr>
<tr>
<td><img src="image9.png" alt="image" /></td>
<td>Export the animation to a frame file</td>
</tr>
<tr>
<td><img src="image10.png" alt="image" /></td>
<td>Create a servo motor</td>
</tr>
<tr>
<td><img src="image11.png" alt="image" /></td>
<td>Change the connection status</td>
</tr>
<tr>
<td><img src="image12.png" alt="image" /></td>
<td>Create an event</td>
</tr>
<tr>
<td><img src="image13.png" alt="image" /></td>
<td>Include a subanimation</td>
</tr>
<tr>
<td><img src="image14.png" alt="image" /></td>
<td>Create a new transparency at time</td>
</tr>
<tr>
<td><img src="image15.png" alt="image" /></td>
<td>Create a new view at time</td>
</tr>
</tbody>
</table>
### Timeline

The Design Animation timeline is a graphical interface that appears below the Pro/ENGINEER window when you start Design Animation. The timeline displays the items that make up your animation on a line drawing associated to a time scale. The components that make up the animation—including key frame sequence instances, servo motor instances, and connection status—are represented by triangles, diamonds, or circles connected by a line.

You add components to the timeline or edit existing components by using the menu commands or the Design Animation toolbar buttons. You can also easily edit an existing animation by right-clicking on components in the timeline. A right-click brings up pop-up menus that let you edit, copy, or remove the selected component from the timeline. Clicking the middle mouse button moves objects vertically, so you can view them more easily.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action/Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Define component display at time</td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Define the interpolation settings</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Create a new transparency at time</td>
</tr>
<tr>
<td><img src="image4.png" alt="Button" /></td>
<td>Edit the selected entity in the timeline</td>
</tr>
<tr>
<td><img src="image5.png" alt="Button" /></td>
<td>Undo</td>
</tr>
<tr>
<td><img src="image6.png" alt="Button" /></td>
<td>Redo</td>
</tr>
<tr>
<td><img src="image7.png" alt="Button" /></td>
<td>Remove the selected entity from the animation timeline</td>
</tr>
<tr>
<td><img src="image8.png" alt="Button" /></td>
<td>Zoom in on the time scale</td>
</tr>
<tr>
<td><img src="image9.png" alt="Button" /></td>
<td>Zoom out on the time scale</td>
</tr>
<tr>
<td><img src="image10.png" alt="Button" /></td>
<td>Zoom to refit the time scale</td>
</tr>
<tr>
<td><img src="image11.png" alt="Button" /></td>
<td>Change the animation time domain</td>
</tr>
<tr>
<td><img src="image12.png" alt="Button" /></td>
<td>Change the assembly tolerance</td>
</tr>
</tbody>
</table>
The timeline is not only a convenient way to represent your animation; you can also use it when you want to change your animation’s time parameters. You can change the time when a specific event occurs by dragging the event’s symbol to a different location on the timeline. For example, you can change the time when an animation or key frame sequence begins or ends by left-clicking on the desired sequence and dragging the line connecting the separate components to a new location with respect to the time scale. You can also position the key frame sequence for convenient viewing.

The following is an example of a Design Animation timeline:

As the animation time progresses, the components in the timeline become enabled at the appropriate time and move associated bodies to their desired positions. Multiple components may be enabled at any given time.

In addition to the components shown in the illustration, an animation can contain information on enabling and disabling servo motors, information on viewing the animation from different orientations, information on blanking or unblanking your assembly components, and information on making your assembly components transparent or opaque.
Limitations

Following are the limitations associated with Design Animation:

- Any definition (body, joint, servo motor) created in integrated Motion is not available in Design Animation. It is available if created in Mechanism Design.
- You cannot transfer data from Design Animation to Motion, but you can use snapshots and servo motors in Mechanism Design.
- Pro/ENGINEER constraints are not honored in Design Animation, but they are used in the initial body definition.
- If you export your animation to a frame file (extension .fra), it does not save the view orientation.
- Constraints and locked bodies (to ground) are saved with a snapshot. However, they are not enforced during a key frame sequence animation. You may need to define body locks and connections within Design Animation to get the desired animation.
- View interpolation settings must be set for the entire animation. These settings are not honored in subanimations.
- Opening a simplified rep may cause animation components to be deleted. If you then save the animation and open the master rep, you may lose information. To retain the master rep animation, do not save the simplified rep. This is also true for suppressed components.
Creating an Animation

Using the Design Animation timeline and toolbar, you can create an animation for your assembly. Read the following topics for an introduction to the components of an animation.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>2-2</td>
</tr>
<tr>
<td>Using Bodies</td>
<td>2-4</td>
</tr>
<tr>
<td>Taking Snapshots</td>
<td>2-4</td>
</tr>
<tr>
<td>Defining a Key Frame Sequence</td>
<td>2-5</td>
</tr>
<tr>
<td>Working with Servo Motors</td>
<td>2-6</td>
</tr>
<tr>
<td>Body Locking</td>
<td>2-7</td>
</tr>
<tr>
<td>Working with an Event</td>
<td>2-7</td>
</tr>
<tr>
<td>Connection Status</td>
<td>2-8</td>
</tr>
<tr>
<td>Working with the Animation Appearance</td>
<td>2-8</td>
</tr>
<tr>
<td>Design Animation Tips</td>
<td>2-8</td>
</tr>
</tbody>
</table>
Overview

You can create an animation to do many different things. Depending on your objective, you may use different steps to create your animation.

Following are the typical steps you might take to create an animation:

1. Open an assembly in Pro/ENGINEER and start Design Animation.
2. Create a new animation and give it a meaningful name using the **Rename** command.
3. Check your body definitions:
   - For a Pro/ENGINEER assembly, you probably want to select **One Part per Body** and then edit the body to put the parts into the appropriate moving groups. **One Part per Body** will empty the ground body of parts. You should edit the body named ground and reassign ground parts to it.
   - For a Mechanism Design assembly, you should check that the body definitions are as desired.
4. Define animation components that create movement.
   - To specify general movement, create key frame sequences. To create key frame sequences, take snapshots of your assembly at specific positions, using the drag functionality to move bodies to new positions. Design Animation will interpolate between these key frames to produce a smooth animation.
   - To create specific movement between bodies connected by joints or between geometric entities, define servo motors on joints or geometric entities.
5. If not already on the timeline, include the servo motors and key frame sequences on the timeline. Any components included on the timeline form the basis for your animation. You can edit the timeline length and increments, as well as the length of the servo motor or key frame sequence in the animation.
6. Optional: If you have not already included body locking, events, or connection status in the timeline, you can add them now.
   - If you want a group of bodies to be fixed relative to each other for a part of the animation, you may want to set up body locking for that time period.
   - Changing the connection status is useful for assembling and disassembling your model. If you are working with key frame sequences, you have probably changed the connection status while dragging bodies to position them in snapshots. If you are working with servo motors, you want to use the **Animation > Connection Status** command, or click  on the toolbar.
   - If you need to have animation components sequenced in a particular order, you can specify a system-defined or user-defined event as a reference, or you can group them together in a subanimation.
7. Run your animation.
8. If you have problems, try one of the following:
   - Make sure your mechanism is not overconstrained. For example, check that a servo motor and key frame sequence do not require conflicting positions.
   - Increase the number of time steps (Tools > Time Domain or click \(\text{\textbullet}\)).
   - Try changing the tolerance (Tools > Animation Settings or click \(\text{\textbullet}\)).

9. Use the Playback dialog box to rerun the animation. If desired, check for interference and other results.

10. Define views along your animation to view the orientation and magnification of your model. Also, choose an interpolation method for your views.

11. Specify component displays along the animation for your assembly components.

12. Rerun the animation and view results.

13. Save your animation and results. You save your results using the Save button on the Playbacks dialog box. Design Animation saves your playback results to a .pba file. To save the animation to disk, you must save the entire assembly using File > Save. Design Animation saves your animation to the .asm file with your model. You can also export to a .fra file, or you can save the animation as a graphic file.

   See the following sections for more information about bodies, snapshots, key frame sequences, servo motors, events, connection status, and body locking.
Using Bodies

A body is a group of parts that move as a unit. There is no relative motion of parts within the group. You can define a group of parts as a body in Design Animation, or you can add components to a body that was defined in Mechanism Design.

Body definition is important because you can define movement and create body locking only between distinct bodies.

Following are the rules for body definitions:

1. By default, bodies in Design Animation are created using the Mechanism Design body rule. The Mechanism Design body rule is that parts with a Pro/ENGINEER constraint (not a connection constraint) are placed in a single body.

2. Once you modify a body definition in Design Animation, the modified body definition holds. Any new parts subsequently added to the assembly are placed in bodies following the Mechanism Design body rule. **One Part per Body** is considered a body modification operation.

3. Bodies defined in a subassembly cannot be modified in the parent assembly. For example, you cannot add or delete a part to a body redefined in a subassembly.

   **Note:** Neither the **One Part per Body** nor the **Default Bodies** operations on the **Bodies** dialog box will override the body definitions contained in a subassembly.

When you add parts to a body, they are deleted from any other bodies that previously contained them. If you delete a body, all of its parts are moved into the Ground body.

Editing body definitions may cause connections, servo motors, and other animation components to become invalid. Invalid components are permanently deleted from the animation timeline.

   **Note:** Any change you make to a body definition in Design Animation will only be valid while you are in Design Animation. You cannot transfer the body definition to Mechanism Design.

Taking Snapshots

You use dragging to place bodies in their desired position for a snapshot. You can drag a point or body. You can choose free-form movement, or movement along a coordinate system axis. Design Animation attempts to position the selected entity as close as possible to the current cursor location. The **Drag** dialog box displays the coordinates of the drag point with respect to a selected coordinate system and updates the coordinates as you move the model. You can use this display to place your component more precisely, or to recall a previous position. When the desired orientation is reached, you click the snapshot button to capture the current position and orientation of each body in the model.
You can choose to have connections between bodies remain connected during the dragging process, or you can disable the connection. You can also apply two types of temporary geometric constraints to the model—**Align** and **Mate**. The constraints are in effect only during the dragging operation. You can select points, lines, or planes on the model for alignment. When you align two planes or surfaces, they become coplanar and face the same direction. When you align lines they become coaxial. You can mate only planar surfaces. When you mate planes, they face each other. You can also orient two planes to be parallel, and specify the distance separating them.

You can constrain the relative position of the bodies connected by a joint by entering a value for the joint axis position.

You can specify that one or more bodies remain stationary relative to ground during a dragging operation by locking them. You can also lock or disable a connection, so it does not move or is ignored, respectively. Design Animation saves the body locking and connection status information with the snapshot, so if you edit a snapshot those features will be active.

If you are creating a new key frame sequence or editing an existing key frame sequence, the snapshots you take are automatically added to the key frame sequence. However, if you click the button on the Design Animation toolbar to create snapshots with the **Drag** dialog box, Design Animation will not automatically add the snapshots to any key frame sequence instance in the animation.

## Defining a Key Frame Sequence

A key frame sequence is a series of snapshots that show the change in position and orientation of parts or assemblies over a period of time. You define the body locations relative to ground or to another body. You decide whether each body’s position is required, desired, or unspecified. Design Animation will interpolate between these key frames to produce a smooth animation.

A key frame sequence definition includes the following items:

- name
- bodies controlled by the sequence
- ground or other reference body
- time of each key frame (snapshot)
- locations of the bodies

You make a key frame by moving the model into the desired orientation and taking a snapshot. After a group of snapshots is prepared, you place them in the desired order in the key frame sequence. After you prepare and save snapshots, you can reorder them in later key frame sequences.
While creating or editing a key frame sequence, you can preview existing snapshots, change the order of the snapshots, make new snapshots, and add snapshots to the key frame sequence. When you include the key frame sequence as an instance in an animation, it appears in the timeline window. Each key frame is represented by a triangle, and a line connects the triangles. You can drag a triangle on the timeline to a different time and the associated key frame will update automatically.

When creating the sequence, you control the importance of each body’s location by specifying whether its status is Required, Desired, or Unspecified. Any body that has its status set to Unspecified is not controlled by the sequence. You also select a reference body, which can be ground, for the entire sequence. All bodies whose status is required or desired in that sequence will be placed in the appropriate position, as defined by the snapshot, relative to the reference body at each time in the sequence.

If the reference body moves, all of the controlled bodies in the sequence will then move with it.

When you run your animation, if the bodies do not move to the correct position, especially at key frames, you should try using the Required status. In general, however, you should use Desired, because Required may over-constrain your assembly.

The entire key frame sequence can be reversed. This is useful, for example, in illustrating the assembly of a mechanism. If you remove the parts of your assembly one by one in a key frame sequence, reversing that key frame sequence produces an animation illustrating the assembly of the model.

Working with Servo Motors

You use servo motors to impose a particular motion on your mechanism without regard to what forces are required to cause the motion. Servo motors force a specific type of motion to occur between two bodies. You can place servo motors on joint axes or between geometric entities such as points and planes on different bodies.

Design Animation offers several types of servo motors. When you define a servo motor, you first specify how you want the motion to change with respect to time—either by position, velocity, or acceleration—and whether you want the motion to be translational or rotational. Within these broad categories, Design Animation provides several profiles you can use, including ramp, parabolic, and polynomial. In addition, you can define your own servo motor function, either with a table, or with a mathematical expression. You can define, edit, or copy servo motors in both Design Animation and Mechanism Design, and the servo motor definition will be valid in both applications.

Once you define your servo motor, you can include an instance of the servo motor for a specified length of time. You can include the servo motor multiple times in the animation and specify that each servo motor instance is applied at a different time during the animation. For each instance, the servo motor function will be evaluated using relative time from the start of the instance.
Body Locking

You can use the multi-body locking functionality to lock bodies to a lead body. Design Animation determines the relative position and orientation of the follower bodies with regard to the lead body at the time the body locking becomes active in the animation and keeps them in this same orientation while the lead body moves according to the animation’s definition. When body locking ends in the animation, the bodies are allowed to move independently again.

Working with an Event

Events are used to synchronize animation components relative to one another. The beginning of the animation is a default event named “start.” As you include components in an animation, you can set them to start or stop at some time relative to the beginning or end of other components. This means that you can associate components so that their relationship in time is maintained through subsequent changes. You can rearrange the order of your components to draw attention to the most important part.

For example, you can define an animation that includes several components. In the following figure, the animation includes two key frame sequences, Kfs3.2 starting at time 0 and Kfs1.4 at time 2 seconds. In addition, there are two connection status events. A joint is disabled at time 1 second (noted by a hollow circle) and enabled at time 2 second (noted by a filled-in circle). All four of these components are defined with respect to Event2, which in turn is defined as beginning at the start of the animation.

Suppose you decide to insert a third key frame sequence, Kfs2.6, in front of this sequence of events. Define the Start time for Kfs2.6 as the start of the animation, then change the start time for Event2 to 2 seconds after Start. The other events that are linked to Event2 are automatically shifted ahead in time without changing their relationship to each other.
Connection Status

You can change the status of a connection during an animation. Using this functionality, you can disable a connection so a servo motor can move a body, then enable the connection so the body moves with its connected body. Changing the connection status is useful when assembling and disassembling a mechanism during an animation.

Working with the Animation Appearance

After you are satisfied with the way your assembly moves during the animation, you can adjust the appearance to emphasize certain portions of the animation.

- You can move smoothly from one orientation of your model to another during the animation by using the view-at-time functionality. For example, you might want to begin the animation by viewing the assembly from the top, and then zoom in on a portion that is moving.
- You can define different display states, in which you make the less important parts of the assembly invisible, with the parts that you want to emphasize shaded.
- You can use the transparency-at-time functionality to make one of the assembly's components completely opaque at one point during the animation, then smoothly make its surfaces transparent, so that the components hidden beneath it gradually become visible.

Design Animation Tips

Following is some helpful information you should know when using Design Animation:

- By default, a key frame sequence controls locations of all of the bodies during an animation. If you want the bodies to be able to move more freely—for example, if a servo motor needs to move them—you should specify that the body definition is Unspecified instead of Desired when defining a key frame sequence.
- When creating constraints during drag, multiple planar constraints can easily lock up an assembly if the constraints close a loop. It is very difficult to keep plane normals aligned. Try to avoid closing loops or using other constraint types.
- When adding a constraint to a long chain of connected bodies, try to add the constraints to bodies that are "near" each other.
• Dynamic spinning works best when you use the screen center option on the Orientation dialog box. You can access this dialog box using Pro/ENGINEER’s View > Orientation > Reorient command. Select Dynamic orient in the Type pull-down menu. When this is done, try to get the spin center icon to be over a physical part. This makes dynamic spinning behave much better.

• Key frame sequences have a lot of freedom to move parts around. When parts move unexpectedly, try tying things down using body locking and constraints.

• If you are using an assembly created in Mechanism Design, you should use Lock Bodies to regroup parts into groups if you are animating after an assembly sequence.
Animation
  definition of time domain, 1-3
  steps to create, 2-2
  using body locking, 2-7
  Animation time domain, definition, 1-3

Bodies
  definition, 1-3
  using in animation, 2-4
  Body locking, 2-7

Connection status
  definition, 1-3
  description, 2-8
  Connection, definition, 1-3

Design Animation
  buttons on toolbar, 1-5
  introduction, 1-2
  limitations, 1-8
  overview, 2-2
  taking snapshots, 2-4
  terminology, 1-3
  timeline, 1-6
  timeline example, 1-6
  toolbar window, 1-5
  using a key frame sequence, 2-5
  using an event, 2-7
  using bodies, 2-4
  using drag to take snapshots, 2-4
  using servo motors, 2-6

Event
  definition, 1-3
  example, 2-7
  system-defined, 1-4
  using in animation, 2-7

Geometric constraints, definition, 1-4

Key frame sequence
  defining, 2-5
  definition, 1-4
  Key frame sequence instance, definition, 1-4

Multi-body locking, definition, 1-4

Servo motor instance, definition, 1-4
Servo motors
  definition, 1-4
  using in animation, 2-6
Snapshots
  definition, 1-4
  taking, 2-4
Steps to create an animation, 2-2
Subanimation, definition, 1-4
System-defined events, definition, 1-4
T
Time domain, definition, 1-3
Timeline window
example, 1-6
example of event, 2-7
Toolbar buttons, 1-5
Transparency at time, definition, 1-4

V
View at time, definition, 1-4